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Safety Symbol Legend

Caution

Indicates a procedure or condition
that, if not strictly observed, could
result in damage to or destruction
of equipment.

Note Indicates an essential or
important procedure or statement.
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Functional Description

For assistance, contact:
Industrial Systems
Product Service Engineering
1501 Roanoke Blvd.
Salem, VA 24153-6492 USA
Phone: + 1800533 5885
(United States,
Canada, Mexico)
+ 1540378 3280
(International)
Fax: + 1540387 8606 (All)
(“+” indicates the
international access code
required when calling from
outside of the USA.)

This document provides instructions for configuring the Data Historian using the GE
Control System Toolbox. The Data Historian records control signals from
Innovation Series™ drives and controllers, and a personal computer (PC). Data is
saved in a Data Collection and Analysis (.dca) file format. The program runs in the
background as a service on the PC that is running the Windows NT® operating
system.

The Data Historian records the value of the following signals:

*  Signals on a drive local area network (DLAN+) to which a controller is
connected

»  Ethernet Global Data (EGD) signals on any Ethernet™ connected to
the PC on which the program is running

*  Control Signal Freeway (CSF) signals if the PC has an ARCNET board
for CSF

* DLAN-+ signals if the PC has an ARCNET board for DLAN+

*  SRTP signals if the PC has the Programmable Logic Controller (PLC)
Interface

The Data Historian also uploads and saves data that has been captured at high speed
in the controller using a Capture Buffer block. It records Drive Capture Buffers for
drives connected to controllers on the EGD internet. Once collected in the .dca
format, data can be accessed by the Trend Recorder or by other GE data analysis
applications.

Innovation Series is a trademark of General Electric Company, USA.
Windows NT is a registered trademark of Microsoft Corporation.
Ethernet is a trademark of Xerox Corporation.



Working with Files and Menu Commands

The Data Historian is configured using one of two types of configuration files: Data
Historian binary or project. These configuration files generate output files that can be
downloaded to the Data Historian service.

The two types of configuration files are:

e Data Historian binary (.reb) file is the binary form of the configuration created
through the File \ Save command. This file can then be exported to a project
file.

*  Project (.prj) file is a text file that holds configuration information.
Output files include:

e Data Historian build (.rcd) file contains all of the configuration information
and is created by the Device \ Build command.

*  DATAHISTORIAN.CFG is simply a copy of the .rcd file that is placed in the
Data Historian’s output directory during a download. This file is read by the
Data Historian service when it is started or when a message is received that the
configuration has been downloaded.

Menu Commands

Data Historian menus, such as File, Edit, and View, are managed just as other
toolbox and Windows menu commands.

Device Menu

The Device menu contains the following commands:

Get From Databaze
"W alidate

Build

Dawnload

Get From Database retrieves signal information from the database. Each time that
a signal is added, you must use this command.

Validate checks the configuration for errors. The results are posted in the Log
View. Before you can validate a configuration, you must:

*  Specify addressing parameters in the Addressing Parameters dialog box
(host computer and host IP address).

*  Specify collection information in the Modify Collection dialog box.
*  Add all signals.

Build creates the Data Historian build (.rcd) output file. The .rcd file is a binary file
that contains all of the configuration information.

Download sends files to the specified Data Historian. This command attempts to
open a connection to the Data Historian service and send a copy of the .rcd file to it.
The Data Historian service creates the file DATAHISTORIAN.CFG on the host
computer, listed as the Data Historian host name in the configuration.
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Data Historian Concepts

The Data Historian is configured in the toolbox as follows:

Any errors encountered while
issuing commands are posted
in the Log View.

I.

Create a Data Historian configuration. Choose a Data Historian host. (Since
there may be different Data Historian services running on different NT Host
systems, specify the service by naming the Host NT box and, optionally, its IP
address.)

Add a collection. A collection is associated with only one network and/or
controller with access to the signals on that network.

Attach signals to the collection (found on the same network). Signals can be
chosen individually from the Signal Selector dialog box or from the Signal
Database (SDB) browser.

From the Device menu, select the commands (or associated buttons) Get from

g
Database L. Validate ¥ . Build |*B _and Download | .

The configuration (the .reb file) can be exported, which produces a .prj file.

Configuration

Or click

Click the System

This section defines the four major areas of interest when configuring the Data
Historian as follows:

Create configuration
Collections

Signals

Dead bands

Creating the Data Historian Configuration

> To create a configuration

*

Hew

From the File menu, select New. The New dialog box displays.

Configuration tab.

Then click Data Historian
Configuration to highlight
it, and click OK.

Egn[rg"ergl Dirives & Exciters é}lstem Canfiguration | |_|[i|i[ieg| Other |

Systern Information Cancel
Metwark. |nterface

D ata Historian Configuration
Senies 90-70VME Interface

e

Help
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Modifying the Device Name
The Outline View on the left side of the window displays the following:

The Data Historian is given the
default name, dh7. You can modify _d,lﬂ—
this device name and then enter the ‘. Collections
Host Name and Host IP Address.

» To modify a Data Historian device name
1. From the Outline View, click on the device name to highlight it.
Or double-click on the device 2. From the Edit menu, select Modify. The Data Historian Addressing

name. Parameters dialog box displays.

In most cases, the Host Name 3. Enter the desired device name and the correct Host Name and Host IP
and Host IP Address are the Address. Click OK.

same name.

Host Addressing Parameters

The Data Historian Device Data Historian Addreszing Parameters
Name defaults to dh7. Enter the 1

new name here. Data Histarian Device Name |dh1' —|: ok, I

Enter the name of the PC in the ] C |
Windows domain that is running Data Histarian Host Mame | ' 4””':E

the Data Historian service.

Host IP &ddress I

Enter the name of the PC in the |

TCP/IP domain. This can be a Hozt IP &ddress will default to Data Histarian Host M ame.
text string associated with a
server name or four numbers
separated by dots, such as
255.255.255.255.

When finished entering information, click OK.
Then add a collection (refer to the section, Collections).
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Collections

The Data Historian is configured by adding collections. A collection is a group of
signals found on the same network. Collections have a data management feature that
automatically deletes old files and also limits the amount of disk space the files can

use.

» To insert a collection

1. From the Outline View, click on Collections.
Or click the right mouse 2. From the Edit menu, select Insert First. The Modify Collection dialog box
button and select Insert First. displays.
3. Enter the fields as described in the next section, Modify Collection.
Modify Collection
Enter the maximum size (in MB) for
the directory holding the collected data.
Enter the name of the collection (also is the Enter the maximum time (in hrs.)
name of the Data Historian subdirectory for that the data will remain on the disk
the data that the Data Historian collects). before being automatically deleted.

Data Source defines where the Data
Historian collects data. Select one of
the following:

* Controller Live Data to collect live
data from the controller over DLAN+
or Controller Capture Buffer to
collect data recorded by a capture
buffer block in the controller. The
Capture Buffer complete signal can
be on DLAN+ or EGD and is the
only signal defined in the collection.
Both options must select the name
of the controller.

¢ Data Historian PC Live Data to
collect either DLAN+, CSF, SRTP,
or EGD from the Data Historian PC.
Collection from DLAN+ or CSF
requires the appropriate hardware
board in the PC running the Data
Historian.

¢ Drive Capture Buffer to collect data
recorded by the capture buffer block
in the Drive. The Capture Buffer
complete signal must be on EGD
and is the only signal defined in the
collection. This option must select
the drive name.

Enter the rate (ms) that the data is
collected from the data source.

Modify Collection

Collzction Mame:

Data Source

" Controller Live Data Controller M ame I 'I

€ Corntroller Capture Buffer Contraller P &ddress
& Data Historian PC Live Data

" Drive Capture Buffer Drrive: Mame I 'I

Met Marnne:

Sample Fiate [ms]

= Collection Fil Space (MB] [64

256 & Storage Time (h] |24

Description;

Cancel |

Enter up to 50 characters describing
the collection.

Select the name of the network where the signals
are collected. All the signals in one collection are
from the same network, but the Data Historian
can be configured to collect multiple collections
associated with different networks.
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Signals

Once the collection is created, signals can be added. Select the desired signals from
the collection’s network signals.

> To add signals to the collection
1. From the Outline View, click on the collection name.

2.  From the Edit menu, select Insert First.

To add the next signal, click Or, click the right mouse button and select Insert First. The Signal Selector
on the signal you just inserted dialog box displays.
and select Insert Next.

Note The signal must be on the network chosen for collection or the ger will fail.

Signal Selector

Signal 5elector Ed |

Signal Mame Begionz: Ok, |
I Cancel |
% denroy:c:hprojec - Loc?te th_e
£ BBR1 Help | desired signal
S o re
g DBEERT — Click on the
NS signal to add it
3 MMI1 to the Signal
C1 P_UC Name list.
£ Rl El Click OK and
So Tun the signal
Signal Dezcription displays upder
the collection
I name in the
Outline View.
Lizt Signals of Type: Show Signals Eram:
I.-'-‘-.II Types j Idenrn:nj,l:n:::'xprniec:tshsdh'xmy_j

Tip & The SDB Browser can be used to add multiple signals. The query used for
the find should include the network chosen in the Modify Collection dialog box.
Using the list of signals returned from the query, you can perform a multiple select,
and then drag-and-drop from the Browser to the collection.

A completed device configuration displays in the Outline View as follows:

dh1
=- Collections
= coll
. BER1\NO_FLT
. DBERTY_STP_CMD
. ¥_PLC\TX_COL
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Dead Bands

Every signal has a parameter called a dead band. The dead band establishes a range
that the signal can vary before a new signal value is recorded. This function prevents
quantities of insignificant data from being collected. For example, a variable can
vary between 0 — 12 'V, but set at or drift near zero.

Also, if only changes of 0.1 V or more is desired, a dead band range of 0.1 can be set
to prevent a file of meaningless drift values from being created. A dead band of zero
indicates that all value changes, no matter how small, are recorded.

> To set the dead band for a signal
¢ From the Outline View, double-click on the signal name. The Modify Signal

dialog box displays.
Modify Signal [ X]
Change the — Signal Selection

signal name or : :
click Browse to IS0 3THLAN_DIAG_B Browss | Cancel |

locate and select

the name.

Dead Band I':' |
Enter the
required dead & dead band is the minimurn nurber of scaled units a
band and zighal must wary before a new value iz recorded.
click OK.
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